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AULA TEORIA INDIVIDUAL GRUPO AULA TEORIA
1 9

06-Mar 08-May

2 Pitch: Temas 10 Pitch: Análise do Contexto - NOP
13-Mar 15-May

3 11 Pitch: Análise do Sistema - ROP
20-Mar 22-May

4 12 Pitch: Alternativas
27-Mar 29-May

5 Pitch: Descrição livre da captura do problema 13 Pitch: Arquitetura Conceitual - RTLI
03-Apr 05-Jun

6 14 Pitch: Propostas de Verificação
10-Apr 12-Jun

7 15 Pitch: Arquitetura Final - Especificações
17-Apr 19-Jun

8 16
24-Apr 26-Jun

EXAME
03-Jul
17-Jul

Frameworks e Stakeholders Intervenção Sistêmica

OPM e Exploração de Alternativas 

Requisitos

Graduação (grupo): Desenvolvimento de um mini-case de um subsistema usando o Capella
Pós-graduação (grupo): Entrega de um artigo (Formato do SIGE) descrevendo seu case e atividades.

Ciclo de Vida e CONOPs

Exercícios de 
fixação

Exercícios de 
fixação

Arquitetura Conceitual e desdobramentos 

Revisita de Requisitos e o processo de 
Verificação e Validação

Arquitetura Concreta e Carta Morfológica 
Relatório e Gravação de 5min 
com explicação

P2 - Apresentação final da relação entre as etapas

Análise do Contexto e apontamento de 
necessidades

Intervenção Sistêmica e requisitos da missão do 
sistema

Montagem de Alternativas

Arquitetura Conceitual e requisitos do sistema 

Apontamento de etividades de verificação

P1 - Questões conceituais e Mini-Case

Modelagem de Comportamento da Arquitetura

Exercícios de 
correção de 
requisitos

Requisitos dos stakeholders

Arquitetura Concreta com decisões tecnologicas

[TE-265 ENGENHARIA DE SISTEMAS BASEADA EM MODELOS] [2023] 

Arquitetura e Funções. Coesão e acoplamento. 

Ciclo de Vida e CONOPs

Modelagem Estrutural da Arquitetura

GRUPO 
Introdução ao Arcadia e Análise do Contexto Resumo dos 

princípios
Definição do grupo. 
Montagem de apresentação 
do tema. 

Trabalho sobre 
MBSE

Elicitar stakeholders

Exercícios de 
análise estruturada

Mapa de interações

Introdução e Apresentação de Engenharia de 
Sistemas

Revisão e desdobramentos para especialidades
Relatório e Gravação de 5min com explicação.
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CONCEPTIO FRAMEWORK
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Realized Architecture

Conceptual Alternatives

Systemic Intervention

Context Analysis

System Analysis

Logical Architecture

Physical 
Architecture

Operational 
Analysis

Solution Neutral 
Architecture

Design Architecture
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Formalized Needs

System Element Requirements

Flowed-down Requirements

Seed

Problem

Solution

PNOP

NOP

ROP

RTLI

DCA-400-6

Soft
Operational

Research
Problem 

Structuring 
Methods

Multi Criteria 
Decision 
Analysis

Problem 
Simulation

Concept 
Simulation

Hard
Operational
Research

Product 
Simulation

Problem Framing

Ideation

SIL
PIL

SIL
PIL

SIL
PIL
HIL

Specific 
Discipline 
Analysis

Concept 
Simulation

SIL
PIL



REQUISITOS E VV
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EXEMPLO DE MODELO DE ESTRUTURA

•Os requisitos são mais comumente expressos como
declarações de linguagem natural, embora as linguagens
de requisitos matemáticos gráficos e formais também
sejam usadas. 
•Usando linguagem natural, as métricas de qualidade de 

requisitos podem ser desenvolvidas por meio da análise
de cada declaração de requisito nos elementos de um 
modelo estrutural de um bom requisito.
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EXEMPLO DE UMA ESTRUTURA

• Actor. Este é o sujeito da sentença - a coisa que está sendo especificada. Exemplos
(bons e ruins!) são: “the system”, “the interface”, “the function”, ............
• Conditions of Action. Isso define as condições durante as quais a ação deve ocorrer, 

por exemplo. “in Replay Mode”, e/ou as condições iniciais: “upon receipt of a 
message”, “power having been applied”, .....
• Action. Este é um verbo - a ação a ser tomada pelo ator (sujeito). Exemplos são: 

“shall calculate”, “shall display”, “shall fly”, “shall be displayed”.......
• Constraints of Action. Estes qualificam a ação, por exemplo. “at a resolution of 400 

x 1000 pixels”, “within limits imposed by vehicle speed”, ....., e incluir desempenho
• Object of Action. Este é um substantivo, e é a coisa sobre a qual se age ao tomar a 

ação. São exemplos: “the message”, “the input signal”, .....
• Refinement/Source of Object. Estes qualificam o objeto, por exemplo

(refinamento): “of flash priority", por exemplo (fonte): “from DISCON”.
• Refinement/Destination of Action. Estes qualificam ainda mais a ação e podem ser 

adicionais às Restrições de Ação. “in accordance with IEEE 802.11g”, “to DISCON”.
6
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EXEMPLO UTILIZANDO O TEMPLATE



METADADOS
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VERIFICAÇÃO

•A VERIFICAÇÃO de um produto mostra prova de
conformidade com os requisitos - o produto pode
atender a cada declaração "deve" como comprovada
através do desempenho de um teste, análise, inspeção ou
demonstração (ou combinação destes).
•VERIFICAÇÃO é um processo de confirmação de que um

requisito ou sistema está em conformidade.
• Em outras palavras, a verificação do sistema faz a pergunta: o
sistema atende aos seus requisitos?
• A verificação de requisitos faz a pergunta: o sistema
realmente atende a esse requisito específico?



VALIDAÇÃO

•VALIDAÇÃO refere-se ao documento ConOps.
•A VALIDAÇÃO é conduzida em condições realistas (ou

condições simuladas) em produtos finais com o objetivo
de determinar a eficácia e adequação do produto para
uso em operações de missão por usuários típicos.
•A VALIDAÇÃO pode ser realizada em cada fase de

desenvolvimento usando produtos de fase (por exemplo,
modelos) e não apenas na entrega usando produtos
finais.



VALIDAÇÃO X VERIFICAÇÃO

•VERIFICANDO UM
SISTEMA:
Construindo o sistema
corretamente:
garantindo que o
sistema esteja em
conformidade com os
requisitos do sistema.

•VALIDANDO UM SISTEMA:
Construindo o sistema
certo: certificando-se de
que o sistema faz o que
deve fazer em seu
ambiente operacional.X
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ESCOLHENDO UM MÉTODO V&V
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Requisitos
programáticos

Guias do 
Usuário/Planeja

dor de Carga 
Útil

Requisitos do 
sistema

Banco de 
dados de 

experiências

Avaliar os
requisitos para 

escolher um 
método

Contribuição de 
Designers, Analistas

e Técnicos

Forneça
sugestões de 
método ao

Desenvolvedor
de Requisitos

Fornecer
comentários ao(s) 

método(s) 
escolhido(s) pelo

Requirements 
Developer

ØCusto, risco, cronograma, etc. 

ØRevise-os para procurar qualquer
método de verificação exigido pelo
veículo de lançamento / 
transportador

ØPesquise quais métodos foram usados para 
requisitos semelhantes em outros projetos.

OU



ESCOLHENDO UM MÉTODO
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Teste é usado quando:

*Técnicas analíticas não produzem resultados adequados
* Existem modos de falha que comprometem a 
segurança, os sistemas espaciais ou os objetivos da 
missão
*Componentes associados a interfaces críticas do sistema

Demonstração é usada quando:
*A verificação das funções projetadas pode ser realizada através
da observação
*Os resultados tendem a ser "aprovação/reprovação", "sim/não"
*Natureza mais subjetiva, como fatores humanos ou capacidade
de manutenção
*Usa sistemas de voo reais ou representativos

A inspeção é usada quando:
*Desenhos, documentos ou dados podem ser verificados
visualmente para verificar se as características físicas foram
projetadas no produto
*Normalmente usado para características de projeto, 
métodos de construção, mão de obra, dimensões e registros

A análise é usada quando:
*Técnicas analíticas precisas são possíveis
*O teste não é uma opção econômica
*A verificação por inspeção não é adequada
*Técnicas e modelos analíticos foram validados
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FERRAMENTAS DE VERIFICAÇÃO

•O programa de verificação deve ser executado com o
apoio de instrumentos de verificação adequados (ou seja,
equipamento de apoio em terra, simuladores,
ferramentas analíticas, instalações de ensaio, etc.).
• Deve ser dedicado o máximo cuidado à concepção e
verificação destas ferramentas, uma vez que os resultados da
verificação dependem estritamente da sua qualidade.
• Os instrumentos de verificação devem ser normalizados para

melhorar a comunalidade e a reutilização a diferentes níveis.

17



SISTEMA DE APOIO TERRESTRE
GROUND SUPPORT SYSTEM (GSS)
•O (GSS) compreende o equipamento usado para operar o

Sistema por meio da integração de subsistemas, testes
ambientais e operações no local de lançamento.
•O GSS é usado para verificar se o Sistema opera conforme o

esperado e atende às suas especificações de desempenho. O
projeto do GSS a ser usado durante a integração e teste
começa com uma compreensão da missão e do design de seus
subsistemas e instrumentos.
• Isso significa que é necessário que a equipe de integração e

teste (e os projetistas do sistema GSS) estejam extremamente
familiarizados com os vários subsistemas que compõem o
Sistema e a operação do software de voo.
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FERRAMENTAS DE IMPLEMENTAÇÃO

(1) estabelecer as condições de 
funcionamento dos subsistemas dos 
sitemas;
(2) coletar e processar dados do 
Sistema que indicam seu
desempenho em resposta a vários
estímulos;
(3) fornecer o ambiente simulado
sob o qual o Sistema deve ser 
avaliada;
(4) fornecer manuseio seguro do 
sistema.
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EQUIPAMENTOS DE APOIO TERRESTRE
GROUND SUPPORT EQUIPMENT
•Os equipamentos de suporte AIT de sistemas espaciais

são geralmente classificados em mecânicos e elétricos.
• Equipamento de apoio mecânico - Mechanical support
equipment (MGSE) são todas as ferramentas específicas do
satélite necessárias para realizar todas as operações
mecânicas no e com o satélite.
• Equipamentos de apoio elétrico - Electrical support
equipment (EGSE) consiste em todo o equipamento elétrico e
acessórios correspondentes necessários para realizar os testes
funcionais do satélite.
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HTTPS://WWW.CLEMESSY.CH/EGSE/ 

https://www.clemessy.ch/egse/


HTTPS://WWW.ISISPACE.NL/WP-CONTENT/UPLOADS/2016/02/ISIS-
GEM-GENERIC-ENGINEERING-MODEL-OVERVIEW-V1.3.PDF 

https://www.isispace.nl/wp-content/uploads/2016/02/ISIS-GEM-Generic-Engineering-Model-Overview-v1.3.pdf
https://www.isispace.nl/wp-content/uploads/2016/02/ISIS-GEM-Generic-Engineering-Model-Overview-v1.3.pdf


APLICAÇÕES DO MDVE

•Real-time testbed (TerraSAR)
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ARQUITETURA FUNCIONAL
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COMO FOI ESTRUTURADO (LAB):
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COMO FOI ENTREGUE
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ESTRATÉGIA DE INSTRUMENTAÇÃO
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CICLO DE VIDA DA PRÓPRIA 
MODELAGEM
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AIVV PARA A MET. ARCADIA
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• Arcadia sugere basear o IVV principalmente no uso de modelos
como uma descrição de necessidades e soluções para orientar
e estruturar a estratégia IVV e sua implementação. 
•Os requisitos textuais (funcionais) são "traduzidos" em

requisitos de modelo em OA e SA. Estes são rastreados, através
da construção do modelo, a partir da solução (LA e PA) por
links de justificação. 
• Capacidades, cenários e cadeias funcionais estruturam versões

de integração e entrega e campanhas de teste, e garantem a 
verificação dos requisitos do modelo. 
•Os requisitos textuais (não funcionais) permanecem quando o 

modelo não é apropriado para representá-los. 

NO FIM...
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CONCEITOS
https://www.m2doc.org/
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•O projeto M2Doc fornece a geração de documentos do Word 
(arquivos .docx) com base em um modelo de documento e 
modelos EMF.
• A abordagem geral consiste na criação de modelos no formato 

OOXML em que a criação de texto estático se beneficia dos 
recursos WYSIWYG do Microsoft Word. Partes dinâmicas são 
inseridas usando um vocabulário dedicado de código de 
campos OOXML. 
•Os campos são usados principalmente para inserir números de 

página, referências, etc. O M2Doc faz uso de diretivas de 
geração de documentação. Isso permite uma separação total 
entre o documento e as diretivas M2Doc.
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CONCEITOS



38



39



•A linguagem de modelo faz um uso extensivo da Acceleo 
Query Language, que fornece uma linguagem de consulta 
de modelo. 

•Os modelos M2Doc podem ser validados. Se forem 
encontrados erros, um modelo anotado será produzido 
descrevendo os problemas encontrados.
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•Definição dos pontos de entrada do modelo.
• Extração de informações navegando no modelo.

41

PRINCÍPIOS
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• Template user: que já possuem o modelo e desejam gerar o 
documento. 
• Edita modelos e quer produzir documentos

• Template developer: que querem criar seu próprio modelo
• Templates podem ser usados em diferentes documentos.
• Varios templates podem ser usados em um modelo.
• Conhece a estrutura de navegação AQL

• Integrator (Meta-model Expert): que desejam fornecer 
geração de documentos em seu próprio projeto usando 
M2Doc.
• Cria serviços AQL para criadores de templates.
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NÃO É FÁCIL E NECESSITA DE PESSOAS 
ESPECÍFICAS:



BÁSICO DE METAMODELAGEM
https://www.eclipse.org/modeling/emf/
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• EMF : Eclipse Modeling Framework
• Modelagem de dados Java e framework de integração

• Fornece a infraestrutura para realmente usar os modelos em
um aplicativo
• Facilmente acessível
•Open source – EPL licence
• Necessário conhecimento em Java 
• Aliás também em UML, XML Schema
• Baseado em modelagem > geração de código

• Possibilita a produção rápida de modeladores
• Utiliza toda a facilidade trazida pelo Eclipse45



•Um modelo EMF é um conjunto de dados 
• Conformação a um metamodelo 
• Composto por objetos com propriedades e relações 

• Serializado em um arquivo XMI 
•Conceitos próximos aos do diagrama de classes UML 
• Elements ~ Class 
• Attributes
• References ~ Associations 

46

META MODELO



• Um link entre o mundo do desenvolvimento e o mundo da 
modelagem 
• Converte modelos em código e vice-versa 
• Fornece toda a infraestrutura necessária de M / MM / M2M

• Gratuito 
• Licença EPL
• Poucos pré-requisitos
• Pode operar no modo autônomo (sem acesso externo)

• Estabilidade 
• Desenvolvido desde 2002
• No centro da infraestrutura do Eclipse 
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BENEFÍCIOS
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https://download.eclipse.org/modeling/emf/emf/javadoc/2.9.0/org/eclipse/emf/ecore/pa
ckage-summary.html 

https://download.eclipse.org/modeling/emf/emf/javadoc/2.9.0/org/eclipse/emf/ecore/package-summary.html
https://download.eclipse.org/modeling/emf/emf/javadoc/2.9.0/org/eclipse/emf/ecore/package-summary.html


49 https://eclipsesource.com/blogs/tutorials/emf-tutorial/ 

https://eclipsesource.com/blogs/tutorials/emf-tutorial/


ACCELEO QUERY LANGUAGE 
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•A Acceleo Query Language (AQL) é uma linguagem
usada para navegar e consultar um modelo EMF.
•O AQL como mecanismo de consulta é pequeno, 
simples, rápido, extensível e traz uma validação
mais rica do que o interpretador MTL
•O interpretador AQL é usado no Sirius com o prefixo
«aql:»
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INTRODUÇÃO



• From a variable one can access field or 
reference values using the . separator.

• With self being an instance 
of Person, self.name returns the value of the 
attribute name and self.father return the father 
of the person.

• If the attribute or the reference is multi-valued, 
then self.parents will return a collection.

• Calls can be chained, as 
such self.parents.name will return a collection 
containing the names of the parents.

• If one want to access the collection itself, then 
the separator -> must be used, as 
such self.parents.name->size() will return the 
number of elements in the collection 
whereas self.parents.name.size() will return a 
collection containing
the sizes of each name.
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•A noção de contexto 
• Uma consulta AQL se aplica ao seu contexto (denotado por 

“self”) 
•A navegação está em conformidade com o metamodelo 

usando a notação de pontos 
• Acesso a referências e atributos 
• Exemplo : aql:self.ownedSchemas.name 
• No contexto de um Banco de Dados, recupere os nomes dos 

esquemas de propriedade do banco de dados atual. 
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SINTAXE



• Outros exemplos de consulta 
• aql:self.name in a Table context → Name of the Table 
• aql:self.ownedTableElements.name in the context of 

Table → Column names list 
• aql:self.ownedTableElements→size() in the context of a 

Table → Number of columns of the Table 

• Elementos estáticos vs elementos dinâmicos
• aql:'Table_ ' + self.name in the context of a Table named 

'Vehicle' → “Table_Vehicle” 
• aql:’Prefixe' + self.name + ‘Sufixe' → 

“PrefixeVehicleSufixe” 
54

SINTAXE



•Disponível em Window > Show View > Interpreter 
• Trabalha com representações do Sirius
•Mas também em todos os modelos EMF 
•Muito útil para ajustar consultas 
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ESTRUTURANDO AS BUSCAS: INTERPRETER



https://www.eclipse.org/acceleo/documentation/ 

https://www.eclipse.org/acceleo/documentation/


(SUPER) PEQUENO EXEMPLO...
https://www.m2doc.org/
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•Primeiro você precisa baixar Capella. 
•Quando o download estiver concluído, extraia o arquivo 

baixado e execute o executável Eclipe na subpasta Eclipse. 

• INSTALLATION FOR CAPELLA 6.1.X
• https://s3-eu-west-1.amazonaws.com/obeo-

networkaggregation-releases/capella-
extensions/6.1.0_M2Doc3.3.0/full zip (M2Doc 3.3.0)
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INSTALAÇÃO 

https://s3-eu-west-1.amazonaws.com/obeo-networkaggregation-releases/capella-extensions/6.1.0_M2Doc3.3.0/full/org.obeonetwork.capella.update.full.zip


INSTALANDO O M2DOC
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ABRINDO O EXEMPLO

60

Arquivos que são gerados

Templates de textos

Configuradores
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Alt+f9

ctrl+f9



CONSIDERAÇÕES FINAIS
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•Voltamos para o nosso exercício: 

ATIVIDADES PARA A PRÓXIMA AULA
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•Adicionar (i) uma proposta de caso de teste no logical 
architecture e (ii) como o equipamento de fato foi 
instrumentado no physical architecture.
•Gerar um doc com no mínimo uma arquitetura de cada 

camada, trazer o título do diagrama e o diagrama 
automaticamente.

ATIVIDADES PARA A PRÓXIMA AULA

64

Realized Architecture

Physical 
ArchitectureDesign Architecture

Flowed-down Requirements RTLI

Product 
Simulation

SIL
PIL
HIL

Specific 
Discipline 
Analysis


